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Introduction

CellSynth is a music synthesiser, sample player and audio processing

tool.

If you already have a sound knowledge of synthesis, it will not take long

to familiarise yourself with the tools you have at your disposal. 

If you have no prior knowledge of sound synthesis, don’t worry. All you

need is the courage to experiment. In fact, using CellSynth will actually

help you understand how sounds are synthesised on both old analog

machines and modern digital samplers, synths and effect units.

Although CellSynth’s interface will be unfamiliar at first, it will soon

become clear as the cells are represented by simple icons that indicate

their function and the connections and flow of the signal are all repre-

sented graphically.

To help at first, you can turn on CellSynth’s tool tips (Options menu: Tips

- on by default), which will pop up if you leave your mouse over cells or

parameters in the cell edit dialog. Once you have familiarised yourself

with the icons and parameters, you can switch tool tips to only display

sample names, or off completely.

The best way to learn how to use CellSynth’s powerful functions is to

work through some examples. The first example in the “CellSynth by

Example” Chapter can be followed as a tutorial and each stage can be

checked against the finished steps (the Matrix files of each step are

provided on the CellSynth CD).

Power to Create…

Underneath the deceptively simple looking interface lurks incredible

power and flexibility. The Cells are the building blocks that can create

sounds that are limited only by your imagination and creativity.

Create familiar sounds such as that of traditional analog synths by using

the sine, square, saw-tooth and triangle cells as sound generators and

modulators, following the methods used since the beginning of electronic

sound synthesis.

But why stop there … add samples, either used traditionally, as you

would in a sampler, or apply any of CellSynth’s features to them.

Anything is possible.

Powerful MIDI support allows real-time control over CellSynth from any

MIDI controller, or the built-in Event Sequencer can be used to program

note or controller events, allowing automated mixes and effects.

CellSynth can also be synced to clock to allow it to be used as part of a

larger MIDI setup.

This all adds up to a program that really does have the power to create

whatever your imagination can dream up.
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System Requirements

Mac Version

• A 100 MHz Powermac with at least System 7.5,or even better, 

OS 8. (The faster the Mac the more CellSynth can do!)

• At least version 3.0 of Sound Manager.

• Mac must be able to play stereo 16 bit audio at 22050 or 44100.

• A monitor capable of displaying 1000s colours.

• A sense of fun!

Bear in mind that to get the full benefit of CellSynth you need at least a

150MHz machine. Having said this, the 22050Hz version CellSynth

works fine on machines down to 100MHz. Although on slower machines

it may not be possible to process incoming MIDI and audio and record

to hard disk at the same time.

If you notice the performance of your mouse degrading then you are

reaching the limits of what you can do with CellSynth.

PC Version

The PC version was still in development at the time of writing. All differ-

ences, including system requirements, will be documented in an

Addendum.
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Learning How to Use CellSynth

This Manual

Well done! You’ve taken the trouble to look at this manual. That’s a good

start in learning how to use CellSynth.

This manual is designed to be self-sufficient, i.e. if you are reading a

printed copy, can read it away from your computer. Hopefully there 

are enough screen shots so it makes sense no matter where you are

reading it!

If you are viewing the manual on-screen, you can make use of its inter-

activity. If you want to find out more about something, try pointing the

mouse at it on the screen. If it turns to a pointing finger you can click to

jump to more information about that feature. For example, all the brief

descriptions of the cells have links to more detailed reference (describ-

ing all the parameters). Clicking on the Cell button shown alongside each

description will jump to the relevant section at the back of the manual.

CellSynth’s Online Help

CellSynth has an extensive online Appleguide. To access this either

choose CellSynth Help from the Help menu or press Command-H.

You can search the online help for subjects and keywords.

Some subjects have interactive examples.

Example Matrix Files with
Annotation

CellSynth is provided with a series of example Matrix Files. These are

easily accessible using the pop-up menu at the top of CellSynth’s main

round window.

Each of these have a description of how they have been made in the

annotation window. The Basic Examples are the building blocks of more

complex sounds while the MIDI Keyboard Sounds demonstrate playable

sounds and Workable Demos are almost complete tracks in themselves

(they have been simplified to run on lower spec computers – check out

the audio files on the CD for full quality examples. 

Click to get more information.

Command-hyphen to return

to where you just came from.

Each time you press these

keys together you will jump

back a step.
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Installation

Which Version of CellSynth?

There are 2 installations on the CD, one for faster machines and one for 

slower machines. 

CellSynth has been tested on PowerMacs from fast G3s down to

100MHz powerbooks.

Obviously the faster your machine the more you will be able to do with 

CellSynth.

To install, you simply drag one of the installation folders to your hard 

disk.

Fast Machine (604/G3 running at 150
MHz or faster

If you have a machine that is faster than 150 MHz then drag the folder 

called CellSynth 604/G3 (150 MHz+) to wherever you want it on your

hard disk. This installation contains a CellSynth application that runs at

CD quality (sample rate of 44100Hz). If you want, you may also copy

the CellSynth application "CellSynth 22050" from the other installation 

folder. If you find that CellSynth behaves slowly or the audio cracks up, 

try using the 22050 version instead of the 44100.

Slower Machine (601 running at 150
MHz or less

If you have a machine that is slower than 150 MHz then drag the folder 

called CellSynth 601 (up to 150 MHz) to wherever you want it on your

hard disk. This installation contains a CellSynth application that runs

with a sample rate of 22050Hz. And some of the demo files are cut

down to try and avoid processor overload. (If you really want to there is

no reason why you shouldn't check out the 44100 version, but you may

find it less useful).

You can also listen to the demo audio tracks on the installation CD.

To avoid unnecessary problems PLEASE TAKE THE TROUBLE TO READ

THE “READ ME” FILES which will have up-to-date information that may

not have made it into this manual.

Note on Processing Power

It is possible to run CellSynth even on slower 100MHz machines but it

will be VERY limited and the interface (graphics/mouse and drawing) can

slow down considerably while CellSynth is playing.  On machines from

200MHz upwards, these problems do not exist and it is possible to get

maximum reward from CellSynth.

Reverb cells use a lot of processing power, and so does recording to

hard disk while playing. So if you have a slow machine and you find a

CellSynth file that does not work, try deleting any reverb cells first.
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Folders Installed with CellSynth

Matrix Files

Example Matrix files. 

You can save your favourite Matrix files into the Matrix files folder. 

This folder should be in the same folder as the CellSynth application.

If it is then its contents will be available in a popup menu at the top of the

round window. The popup menu can be used as a shortcut to aid loading your

favourite Matrix files. Make folders (one level deep only) to group your sounds

into submenus.

Event Sequences

Some pre-made Event Sequences which can be used to control CellSynth 

(with MIDI notes and controllers).

Harmonic Tables

Example files for the harmonic editor.

MIDI Programs

This will be empty on installation. Aliases of Matrix files can be put in

this folder and will be loaded when CellSynth receives a MIDI Program

Change. This is explained fully later in this manual.

Tutorial 1

Files used in the examples in this manual.

Thank you for purchasing CellSynth and a big thanks if you were one of the Beta

Testers! Living Memory wish you many enjoyable hours of CellSynthesis!



CellSynth Main Window – Page 9

Cell Store

Peak Level

Cell Store

Matrix

Generator Cells

DSP Cells

Matrix Pop-up

On / Off

Active LED

Matrix Pop-up only appears if

“Matrix Files” folder is in the

same folder as CellSynth.Generator Cells are Oscillators

(Sine, Square,Sawtooth,

Triangle and Harmonic) plus a

random/noise generator and a

sample player.

DSP Cells are cells that can

be used to alter the result of

the signal fed into them.

Like Effects processors.

The 'Matrix' is the name given

to the 36 squares in the

round window. Each square is

called a 'Cell'.You create an

active cell by dragging one

from the cell stores

Click on the speaker to turn

on CellSynth’s audio output.

The speaker will move when

producing output

Glows when CellSynth is 

producing output.

Also glows when CellSynth 

is waiting for MIDI sync

CellSynth Main Window
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Using CellSynth – The Basics

The Matrix

The 'Matrix' is the name given to the 36 squares in the round window. 

Each square in the Matrix is called a Cell. 

Cells can be audio 

generators (oscillator or

sample) or processors

(filter, mixer/amplifier,

reverb, delay, enve-

lope etc.).

Every Cell has up to

4 audio inputs and 4

modulation inputs from

its neighbouring cells; up,

down, left and right.

The audio output

of each Cell goes

not only to its

neighbours but

also (optionally) to

the stereo output

of CellSynth.

You create an active cell by dragging one from the

cell stores at the top and bottom of the round 

window.

Here we have 4 cells:

• a triangle oscillator

• 2 sine oscillators

• and a Mixer/Amplifier 

• The blue lines and white triangles show the

path of the audio signal. 

• Red lines and white semicircles show the

path of modulation.

Therefore this matrix shows that the audio signals from the sine oscilla-

tors are going into the mixer, and the mixer is being modulated by the

triangle oscillator. 

The oscillators are greyed, that means that the audio signal for the cell

is muted (not heard at the stereo output). The output of the mixer cell

is the only audio that can be heard in this matrix.

A Blue cell is

heard at the

Stereo Output

A Grey cell is muted

and will not be heard

at the Stereo Output
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Moving Cells

When you move the cursor over the tile surrounding

an active Cell, the cursor will change to a hand. This

indicates that if you click the mouse button and hold

it, you can drag the Cell to another location.

Editing Cells

To edit a Cell, click once in the Cell Button to show the Cell Edit window.

A Cell Edit window contains all the parameters for the Cell you are edit-

ing.

The first row of controls affect the amount of audio input from the Cells

neighbours (Top, Bottom, Left and Right).

The second row affects the modulation from the neighbouring cells.

When you turn up, for example, the

audio input to a cell from its neighbour

to the left, the Matrix displays a blue

arrow to indicate that the cell is receiv-

ing audio input.

The same is true of the

modulation inputs,

except the line is red.

You can also set the audio input to 1.0

by clicking on the white triangle on the

Cell’s tile on the Matrix and modulation

to 1.0 by clicking on the white semi-circle.
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The Mute, MIDI Control, Solo buttons, some or all of which will be pre-

sent depending on the Cell being edited, are simple on/off buttons.

There may also be a fourth editor button. This opens a further editor

window for the cell being edited. These are discussed in detail later, but

here is a brief tour of these additional editor windows:

The Sample Cell has a window that allows the start and end point of a

sample to be set.

The Harmonic

Oscillator Cell

has a window

that allows the

harmonics to be

adjusted.

The Envelope Cell has a window for graphically editing the shape of the

envelope.

The Event Sequencer Cell has a window for entering Notes and

Controller Events. The Event Sequencer allows you to program arrange-

ments, melodies, arpeggios, basslines, automated mixing, filtering,

effects and more!
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Using the Cell Edit Window’s Dials,
Numerical Displays and Sliders  

The Cell Edit window has dials which represent the knobs on a piece of

music hardware, numerical displays similar to LCD readouts.

There is more functionality built into these controls than first meets the

eye. Here is a quick guide to some of them:

Command-Click – returns the dial to its default setting (although certain

dials, e.g. frequency of a sample, this fits to tempo)

Control-Click – -1 Octave

Option-Click – +1 Octave

Click the dial and drag around it to turn it.
As you move the mouse further away from the dial it becomes more

accurate.

Control and Option clicking in the dial divide and multiply by 2

The Red multiplier switch on the outside of the dial allows you

to set the maximum range. This is particularly useful for set-

ting very low values in oscillator and filters (you might, for example,

want to have a very slow oscillator controlling a filter to create a slow

sweeping filter effect).

The numerical display also has a few extra features.

You can type a value in on the keyboard and it will be

entered in the numerical display of the parameter that has the focus

(the edge of the Display is highlighted in red when it has the focus).

The display for MIDI Controller has a ‘learn’ feature

which can be used to easily setup a MIDI Device to con-

trol CellSynth. Click in the display to give it the focus and then move the

knob, slider or button (or whatever you have available) on your MIDI

device that you wish to use to control the Cell. Now Click once more in

the display and the correct MIDI controller will be assigned.

“Tear Off” Sliders

If you find that you can’t get the kind of control you want from the dials

on the Cell Edit window, click on the display of a parameter you want to

adjust and, holding the mouse button down, drag the cursor away from

the display. A slider will appear. 

click on an LED 
to set the 
resolution

Click above the
thumb to move
it up one notch

Drag the thumb
with the mouse

Click below the
thumb to move it
down one notch

Click on ÷2 or x2
to go up or down
by an octave

x2 (+1 Octave)Multiplier:
Sets Range

increment
decrement

÷2 (-1 Octave)
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These are CellSynth’s ‘tear off’ sliders (fader). You can drag the slider

window to any position you require. Use them to setup mixer like con-

soles to control various elements of your matrix. These sliders remain

open even when you close the Cell Edit window and they are saved with

a Matrix file.

Command-F will hide all the sliders.

The only control we haven’t yet looked at is the switch. If any

parameter can only be on or off, a switch is displayed. 

No hidden extras here, just a standard on / off switch!

A Summary of How Parameters are
Displayed on the Matrix

As we have seen, many of the parameters set in the the Cell Edit win-

dow are reflected on the Matrix. This makes it easier to understand how

the Cells are behaving and interacting.

Some Cells also display additional information on their state:

Here is a Mixer Cell. Turn on Invert and 

the icon displays a minus symbol.

Here is a Panner Cell at its default 

setting of Mid. Pan to the left and the

icon displays it.

You can tell which cell in a Matrix you are editing because its Cell button

appears depressed :( and the Cell’s symbol is displayed in white.

You can also tell from looking at the Cell button, whether its output is

heard at output or not (heard=blue, muted=grey).

There is also a third state which has not yet been mentioned. If the but-

ton appears flat then it has been disabled. 

White Semi Circle buttons
enable modulation input.

Red lines show the
path of modulation

Blue lines show the
path of audio signal

Cell Buttons show cell type
and audio muting. Click these
to open the editor for the cell.

Keyboard button enables
MIDI note-on/off control

White triangle buttons
enable audio input
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The disable function can be used to help understand what is going on in

a matrix. By disabling a cell it is easy to see what its effect on the over-

all sound is. You can disable a whole branch of cells by turning off the

cell at its root.

» As well as the shortcuts shown above, you can also Solo a Cell with a keyboard

shortcut, which can help figure out what’s doing what on a Matrix.

Control - Click a Cell to Solo.

Control - Click the same Cell again to turn off solo.

You can Control - Click a different Cell to Solo one after another.

Blue:
Active and heard 
at stereo output

Grey:
Active and NOT heard 
at stereo output
(Command-click)

Flat:
Disabled
(Control-Option-Command-Click)
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Harmonic Oscillator

This cell produces

a tone consisting

of a user specified mix of

32 harmonics starting at

the fundamental.

The Harmonic

Editor is opened from the

Cell Edit Window by 

clicking on the Editor 

button.

The Harmonic Editor is

used to specify the 

amplitude of each 

harmonic (harmonic additive synthesis).

You can enter values from the keyboard or use the pencil tool that

appears when you move your mouse into the edit LCD.

When the Harmonic Editor is on screen, Open and Save Harmonic Table

options are available on the File menu.

Aside from the Harmonic editor, the Cell Edit window has the same

parameters as the other Oscillators.

A Quick Tour of the Cells

The Generator Cells

Generator cells are located at the top of CellSynth’s main window.

Basic Oscillators

The first four generator cells are basic oscillators as used in analog syn-

thesis:

Sine, Square, Ramp (Sawtooth) and Triangle.

The Basic Oscillators have just the parameters that are common to vir-

tually all Cells - Gain, Controller and Control Amount.

They also have a Frequency parameter which can either be fixed or mod-

ulated by the input.

Gain is the overall output of a Cell. Optimum gain is 1.0.

Controller is the MIDI Controller that will control gain (this is true of

most cells (see “Using CellSynth with MIDI” chapter for more informa-

tion).

Control Amount is the amount of control a MIDI controller has. 127 =

maximum and 0 = off.
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Noise Generator/Random Number
Generator

If the frequency is set to 0 this cell outputs white noise.

If the frequency is > 0 it generates a random number between -1 and 1

at the frequency specified. This has many uses, for example, to produce

sample and hold style effects as found on analog synths.

Sync switch on or off. If sync is on, frequency becomes a multiple of the

bpm. This would be used, for example, to sync a “sample and hold”

effect to the tempo of a song. 1=1/4 note. 2=1/8th note, 4=1/16th

note, and so on.

Sample Cell

This cell allows AIFF files to be loaded as sound sources.

When the cell is dragged to the Matrix, a standard File open dialog

appears. Select an AIFF file to use.

Samples can be auditioned using the Play button in the dialog.

You can also drag an AIFF file straight from the Finder to the Matrix.

» Double clicking on an AIFF file associated with CellSynth (CellSynth’s Type and

Creator) allows the audio to be auditioned. CellSynth will play the Sample, even if

it is not loaded.

Clicking on the Editor button in the Cell Edit Dialog opens a dialog

that allows the Start and End points to be visually positioned.

Using Samples is covered extensively in the example in the next chapter:

“CellSynth by Example”.

DSP Cell Store

The DSP cells, found at the bottom of the CellSynth window, take input

from their neighbours and apply their properties to that input. You can

use them in the same way that you would an effect unit, or hardware

mixer.

Low / Band Pass Resonant Filter

This cell can be switched in the Cell Edit dialog to act as either

a Low Pass or Band Pass filter. 

The Low Pass filter is similar to that found on analogue synths. It lets

the low frequencies through and cuts the high. This will be most familiar

as a “wah” effect.
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Panner

Audio can be positioned in the stereo field using the Panner

Cell.

If you applied modulation to this cell you could make it into an auto 

panner.

Black Box

The Black Box is a stereo spacializer, compressor, limiter,

expander and noise gate. It turns a mono signal into a stereo

one.

When used as a noise gate, it takes its key from the modulation.

Limiter - works like the studio effect, the signal is limited to the value

specified here.

Expander - works like the studio effect, any signal lower than the value

specified is increased.

Decay - the number of sample points that the effect is on.

Delay

A simple echo

or:

if the timing of the echo is modulated it serves as a flanger.

When switched to act as a Band Pass filter, it allows a speci-

fied band of frequency to be cut. A row of these cells could be

set up to act as a graphic equaliser or a single cell used to cut or boost

a specific frequency band.

Comb Filter

This filter is like a fixed flanger or phaser (depending whether

invert is on). The signal is fed back on itself with a slight delay.

You can control the length of the delay (width) and the amount of feed-

back. Inverting the feedback creates a phase effect.

If you were to modulate this cell with a Sine Oscillator, for example, it

would create a sweeping flange or phaser / chorus effect.

Mixer

Used to route the signal from one part of the matrix to 

another.

Can also be used to amplify, attenuate and invert the signal passing

through it.

Switching on “negative to positive” makes all negative signals passing

through into positive signals. One, not immediately apparent, use for

this is to make all numbers generated by the random number generator

into positive numbers.
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Reverb

A stereo reverb that can range from a tiny room to an infinite

cavern.

Note:- Reverb is very processor intensive - this should be the first cell

you delete if your processor is struggling with a particular matrix.

Envelope

Can be used to shape an audio input or as a free standing

envelope.

The envelope shape (ADSR) can be set visually from the Envelope editor

by clicking on the editor button in the Cell Edit dialog.

Event Sequencer

The Event Sequencer is like a mini sequencer, allowing Cells to

be controlled by MIDI notes or Control Events. This is a very

powerful feature, allowing CellSynth to be used as a composition tool,

without even needing a separate sequencer. As the event sequencer can

be used to modulate any of CellSynth’s cells, the uses of this can go far

beyond that of a standard sequencer. Just use your imagination. 

The Event Sequencer window is opened by clicking on the editor 

button in the Cell Edit dialog. 

A full description of how to use the Event Sequencer comes later in this

manual.
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CellSynth as Standalone Sample
Player (including sampling CellSynth’s
output)

The object of this example is to create a simple track consisting of a

few samples.

One of those samples will be a sample of a pure CellSynth

sound, created with simple oscillators and filters, which is

then retriggered with a random start point to create a rhythmic sound

(similar to sample and hold).

Learning to create this sound will demonstrate using the oscillators and

filters, while the final part of the exercise will demonstrate the use of

samples and how they can be synced with CellSynth’s internal clock.

Effects will also be introduced along the way.

Step 1: Oscillators and Mixer

Drag a Sawtooth Oscillator onto the Matrix.

Now drag a Mixer Icon from the DSP Cell Store at the bottom

of the Matrix and drop it to the right of the Sawtooth, and

finally, another Sawtooth to the right again (the reason for 

using two Oscillators will become clear in Step 3).

CellSynth by Example

The best way to learn CellSynth is to actually use it. It will soon become

clear what the buttons, arrows and indicators are representing. 

Although a complicated Matrix may appear daunting at first, it won’t be

long before you can look at a Matrix and read it, as you would a map,

understanding the flow of the signal and what Cell is causing what effect

on the resulting sound.

There are many tricks you can use to help you understand what is hap-

pening on the Matrix, such as soloing Cells or even disabling them

(which, by choosing a strategic Cell, can disable a whole branch.

The first example is described in great detail, and serves as a tutorial

(with all the files needed to follow it through, available on the CellSynth

CD). It covers many aspects of using CellSynth, and introduces short-

cuts and many tips.

After the main tutorial example there are some shorter examples that

cover other areas of CellSynth’s functionality. The MIDI chapter also has

an example you can follow that makes use of the example Matrix files

supplied, as does the chapter on the Event Sequencer.

If the information you are looking for is not found in this manual, study

the example files provided. Each one has a description of their purpose

in the annotation window.
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You will notice that the screenshot shows white triangles and blue rout-

ing arrows. This means that the output of the two Sawtooth Cells has

been routed into the Mixer Cell. To do this open the 

Cell Edit dialog.

» A Cell’s parameters are set from the Cell Edit dialog. Click on a Cell to activate

the Cell Edit dialog.

Using the Cell Edit Window has been covered earlier. You might want to

take another look.

By setting an input of 0.5 from both the Left and Right Cells you will

feed the output of both Sawtooth Oscillators into the mixer.

The optimum gain in CellSynth is 1 (unity gain) so it is a good idea to

set the input gain from each Cell to 0.5.

You can either type a value directly into the Parameter window or

use the dial. 

When you move your mouse over a dial on the Cell Edit Window the cur-

sor will indicate that you can click and drag to alter the setting.

We’ve taken you the long way round to routing input from one cell to

another. Its important to understand the relationship between the Cell

Edit Window and what is displayed on the Matrix. There is, in fact, a

shortcut to do the same thing:

» Clicking on the Triangles routes the signal from one Cell to another.

The last thing remaining to do in this step is to mute the two Oscillator

Cells leaving only the output of the Mixer Cell being sent to the Master

outs.

Click on the speaker button on the Cell Edit Window. This mutes the

cell. (You can also Command Click on the Cell button on the Matrix.)
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You are going to mix the output of two cells through a filter. By muting

the cell you will ensure that you only hear the output that is routed

through the Mixer Cell. If you don’t mute the cell you will also hear the

cell’s own output.

» Muting a Cell means that its output will not be heard at the stereo output. Its

signal will, however, be passed on to any Cells it is routed to.

You can also Disable a Cell by Control-Option-Command-Clicking on the Cell button.

The Cell will have no output and no signal will be passed to neighbouring cells.

Step 2 - Add a Filter

The next step is to add a filter to the output of the Mixer Cell.

Drag a Filter from the DSP Cell Store onto the tile below the

Mixer Cell. 

Note:- This Cell defaults to being a Low Pass Filter but can also be

switched to act as a Band Pass Filter.

» It is easy to move Cells around using your keyboard. Press Tab or right arrow

to highlight the first Cell, then you can move around the tiles of the Matrix using

the Tab or arrow keys until you reach the Cell you want to move. Then Press

Command and use the arrow keys to move the Cell around the Matrix.

The Low Pass Filter is the kind of filter that you would find on an analog

synth. It cuts the high frequencies, only letting the low frequencies

through.You may be familiar with the term “wah”, which is often used to

describe this kind of filter, as in “wah wah guitar”.

The Resonance is, in simple terms, the intensity of the filter (the

amount of “wah”). 

In this example the resonance is increased slightly to 0.7 .

The plan is to modulate the frequency of the filter to create a sweeping

effect.

Step 3 - Modulate the Filter

The Oscillators, as well as being used to produce tones, can be used to

modulate other Cells. This is something that will be familiar to those

who have used analog synths.

In this case we want to sweep the filter up and down, so the

best Oscillator to use will be the Sine wave.

Drag a Sine Wave Cell onto the Matrix, under the left Sawtooth and

next to the filter.
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This time click the small semi-circle on the filter to allow the Sine wave

to modulate the Filter.

» The Semi-Circular buttons on each tile allow the tile’s Cell to be modulated by

the neighbouring Cell’s output. This is the shortcut for adjusting the modulation

input in the Cell Edit Window.

Adjust the frequency of the Sine wave to create a slow sweep. In this

example we used a value of 0.1 (one cycle every 10 seconds).

Making full use of the Sine wave, we are also going to use its output to

modulate the Sawtooth Cell above it. By modulating the frequency (pitch)

of the Oscillator, it will create a richer sound as it beats against the

fixed pitch of the second Sawtooth Oscillator.

Click on the Sawtooth cell to open its Cell Edit window.

Set the modulation input from the bottom to a very small amount. In

this case we used 0.004 . The Cell Edit window doesn’t display figures

to this number of decimal places but you can enter them from the key-

board.

Click in the modulation LCD display to gain the focus (red outline) and

type the value you require.

Notice how the LCD display is outlined in red to indicate that it has the

focus and will accept your input from the keyboard.

Step 4 - Add a Second Filter to Double
the Slope

To get a really dramatic filter sweep, a second filter can be added.

Drag another Low Pass filter to the position on the Matrix

under the first.

We want to use the same modulation we used on the first filter but how

do we route it into the second filter. We could simply use another Sine
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Cell but it would be better to route the output of the original Cell into

the new Filter. That way any changes made would be replicated in both

filters.

» The simplest way to route the output of a cell from one place to another is to

use Mixer Cells with their gain set at 1 to pass the signal straight through.

Place a Mixer cell underneath the Sine Cell we are using to modulate

the filters.

Take the output of the Sine Cell through the Mixer Cell and use it to

modulate the Filter.

Step 5 - Add Reverb and Record

Add a Reverb Cell and route the output of the filters through

it.

You will notice, in the example Matrix, that all the Cell’s are muted

except for the output of the reverb. This is the equivalent of taking the

‘wet’ signal only. and was done purely because it sounded good. If the

second filter had been left unmuted you would have had the usual mix of

‘dry’ and ‘wet’ sounds.

Now its time to record the output of CellSynth to disk so that it can be

loaded back into a Sample Cell.

» It takes much less processing power to play a Sample than to create a sound

using lots of cells. If your sound is making your Processor work hard then record

it and load it back into a Sample Cell.

You can tell how hard your sound is hitting your processor by displaying the CPU load

indicator.

In this case, the main reason we want to record the sound produced by

our Matrix is that we can then use one of CellSynth’s unusual features

to create a rhythmic “sample and hold” type of effect. This is in fact

achieved by randomising the start point of the sample. By cutting in at

random points in the sample we can change a smooth sweep into a ran-

domly jumping filter, but make it sync to CellSynth’s internal clock allow-

ing it to be synced to a tempo.

To record CellSynth’s output you have to

first show the recording toolbar (Options

menu).

To record the sound, click on the record button. Click on Stop when you

have enough of your sound recorded (one full sweep of the filter).
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You can listen to what you have just recorded with the play button.

To save the recorded audio click on the disk symbol.

The audio is saved as a standard AIFF file.

Step 6 - New Matrix

Now we have recorded the sound of our Matrix, we can dispense with it

and start with a new Matrix. You may want to save it in case you want

to make any changes later.

» You can clear the Matrix by pressing Command - b (or going to the Edit Menu

and choosing Clear Matrix.).

We want to import a sample into Cell Synth.

There are two ways of achieving this:

1. Drag a Sample Cell from the Generator Cell store onto the

Matrix.

You will be prompted for an AIFF file to load. You can audition the files

with the “play” button.   

2. You can drag any AIFF file directly from the Finder onto the Matrix.

» CellSynth’s audio is saved in AIFF format ready to be dragged or loaded back

into CellSynth’s Matrix.

You can even audition CellSynth AIFF files when CellSynth is not running. Double

click on the AIFF file in the finder and CellSynth will play the sample and then

close again.

We are actually going to use the same sample twice, so we need to

have two Sample Cells in our Matrix. Instead of dragging two Sample

Cells onto the Matrix, we will only drag one on and create another by

pressing the Option key on the keyboard and dragging the Cell to anoth-

er location, which will make a copy. This will mean that, rather than

storing two versions of the same sample in the Matrix file, only one will

be used but we will be able to apply different settings to each cell.
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This will allow us to create a rich sound by playing them back an octave

apart and modulating their ‘sample and hold’ effect differently.

In “real life” you can move the cells around (as described earlier) as the

Matrix develops. In this example we have the advantage of knowing

exactly where we are going, so drag the AIFF file onto the Matrix, and

duplicate the resulting cell (option + drag) into the positions shown:

We can use the x2 button next to the dial in the Sample Cell’s window

to double the frequency of the sample at the top of the Matrix (or

option-click on the dial or LCD display), raising its pitch by an octave.

Let’s call this ExampleSample B, and our original sample ExampleSample

A for future reference.

Step 7 - Randomise the Start Point

This step is where we create the “sample and hold” style effect.

Add a Random Cell.

This cell can produce noise or can be used to randomly 

modulate another cell, which is the feature we 

need now.

We are going to use this to modulate the start

point of our samples.

Place the Random Cell above the

ExampleSample A.

Click on the semi-circle on the top edge of the

Sample Cell to allow the Random Cell to modulate the Sample.

Make sure you

enable Mod to

Start in the

Sample’s Edit

Window. 

The Random Cell’s Sync should be set to On

(default) so that the effect produced will be in

time with the rest of the samples we are going

to add later.

Set Sensitivity to 1.0 .

x2 (+1 Octave)
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Now we want to route the output of the Random Cell up to the other

copy of our Sample (ExampleSample B - which we raised an octave in

the previous step). As before we can use a Mixer Cell to do this but we

are going to try using the Mixer Cell as an Inverter this time.

Place the Mixer Cell above the Random Cell and route the

output of the Random Cell into the Mixer using the triangle

connector.

Now Modulate the second Sample Cell by linking it to the Mixer Cell with

the semi-circle connector (we’ll assume from now on that you are famil-

iar with how to route the signal from one Cell to another, either as audio

input or as modulation using the triangle and semi-circle connectors on

the edges of each tile).

Now open the Mixer Cell’s edit window and

turn on the invert function. This, as its

name suggests, inverts any value that is

fed into the mixer. 

The effect this has in this example is to

ensure that both samples receive a differ-

ent value, thereby the start point of either

sample is never in the same place.

You will notice that the Mixer button on the Matrix

changes to reflect that it is now an inverter.

Step 8 - Add a Looping Envelope

We are now going to add a looping envelope to ExampleSample B, which

will have an effect similar to using a keyed noise gate, sync’ed to tempo.

Drag an Envelope Cell onto the Matrix below the second 

sample.

Turn on the Loop function, which starts the envelope again once the

decay stage has finished.
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By choosing a decay length that is related to the tempo and switching

on sync, so that the envelope is triggered in time with the tempo, a

gated affect can be achieved

Luckily CellSynth has a feature which makes this very easy to do, so you

can put your calculators away!

With the Envelope’s Cell Edit Window open, Command click on the

Decay dial and the setting will fit to CellSynth’s internal bpm, in this

case the default 120 bpm will give a value of 0.5 (one beat of 4/4 or a

quarter note).

Now Control-Click once to half the value (eighth notes) and once more to

half it again (giving us sixteenth notes, which is the value we require to

give a fast gated effect).

If you prefer to edit envelopes visually, there is also a 

graphical editor which you can call up by clicking on the 

editor button.

» The default tempo of CellSynth’s internal clock is 120bpm. You can alter this

by selecting Set Sync Tempo… from the Options menu.

Note:- This tempo is ignored if CellSynth is synced to MIDI Clock.

Before moving on to the next stage, mute ExampleSample B by com-

mand-clicking on it. This ensures that you only hear the output with the

gate effect.

Step 9 - Add Reverb

Drag a Reverb Cell onto the Matrix. You can place it below the envelope

so that you will be able to feed both samples through it. Remember that

in “real life” you can move the cells around, as described earlier, as the

Matrix develops.

Use the triangle connectors to feed in the input from both samples.

Step 10 - Add the Rhythm 
(using the Sync Start to make a simple arrangement)

We have three samples to use as the rhythm, a bass drum loop, a hi-

hat loop and another loop with more drums involved. By using the 

controls provided in the sync dialog (appears when you turn on sync) you

can add a basic arrangement even using the Event Sequencer!

Go to the Finder and open up the Tutorial folder. Drag the Bass Drum,

HiHat and Drum Loop sample files directly onto the matrix. The position

is not important as they will simply be playing loops and not fed into any

other cells.
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When you switch on

Sync you are pre-

sented with a dialog

that allows you to

specify how you

want the sample to

behave in relation to 

the sync clock.

Lets make a simple intro, starting with the fast gated CellSynth Sample

followed by a 4 bars of bass drum and fast gated CellSynth sample,

joined by hi hats at bar 3 for 1 bars before the full rhythm enters at bar

five along with the slower and lower CellSynth sound.

As the piece is simple 4/4 time, we will leave all the beats per bar at 4.

We want all samples to start on the 1st beat of the bar so we can also

leave the beat field at the default of 1.

The samples vary in length, from a 1 beat bass drum to an 8 beat drum

loop. Each sample will have to be retriggered after a suitable number of

beats.

Go to each sample one by one and set their start points like so:

ExampleSample B
Bar 1 (also we want to retrigger the sample every 4 beats)

Bass Drum
Bar 3 (this is only a 1 beat sample, so lets retrigger every 1 beat)

HiHat
Bar 4 (this is a 4 beat sample, so retrigger every 4 beats)
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ExampleSample A
Bar 5 (this doesn’t really need to retrigger as it is set to loop continu-

ously - in the example it is set to an arbitrary 500 beats)

Drum Loop
Bar 5 (this is an 8 beat loop and must loop every 8 beats)

Now, when we start CellSynth, we’ll hear our intro.

Step 11 - Add More Stereo

Now, lets round off our

example by adding a

Spacializer effect to the

HiHat and Drum Loop.

You will notice that the

HiHat sample is muted to

get the full effect of the

spacializer.

There! Finished.

Just one more thing…

Let’s annotate our Matrix so that we don’t forget how it works.

Annotation

From the Options menu, you can choose to show the Annotation

Window. To enter your text choose Edit Annotation. You will now be able

to enter text in the window.

You can type anything you like in the window.

Perhaps something to remind you how you made the Matrix.

You might want to distribute your Matrix to other CellSynth users. You

can put your credits in this window and it will be saved with the Matrix.
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Well Done!

It may have seemed complicated to get to this point, but as you become

familiar with the features of CellSynth, you’ll be able to knock out some-

thing like this in minutes. It is much more complicated to describe than

to do. Having said that, by looking at each step in detail we have cov-

ered many of CellSynth’s features along the way.

Take a little time to look at the finished example and you will soon get

the feel of the flow of sounds you have created, which cells are muted,

and why, which cells are used as simple sample playback.

Of course, there are a million and one more things you can do with

CellSynth. We haven’t even looked at using MIDI yet.

Using CellSynth for Auditioning
Drum Loops – Part 1:
Recording

This example covers two areas, recording audio and retuning samples to

fit to a tempo.

Quite often, when producing music with sampled drum loops, samples

taken from sources of varying tempo are retuned so that they can be

used together. This can be a tedious task, but CellSynth has some use-

ful shortcuts to make this process much easier.

First, lets look at how you would record samples directly from CellSynth.

Step 1 - Record your Drum Loops

Record your drum loops, either using CellSynth’s record function, or

your favourite audio application. Once you have them in a format that

CellSynth can import, drag them onto the Matrix.

Of course, if you record them through CellSynth, you can use CellSynth’s

features to process the sound.

To do this you must first

“Enable Sound In“ from

the Options menu. 

You will need to choose

the input from a standard

Sound Manager dialog.

The “Sound In” icon will be displayed in the

top left hand corner of the matrix, along

with a Mixer Cell, which is used to connect

the input to Cell Synths output (otherwise

no sound would be heard!)

From here you can feed the input into any combination of Cells, using

CellSynth as an effects processor.

Record the resulting sound using the

Recording Toolbar (Command-B). Record

as close to the number of bars you

require.
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» You can choose the location of the Recording scratch disk by selecting “Choose

Record Disk…” from the File menu.

Save the recorded audio by clicking on the disk icon on the Recording

Toolbar (or Command-B). 

» although not relevant to this particular example, you can set the record time

and Fade Length from this dialog, accessed from the File menu:

Drag a Sample Cell to the Matrix, choosing your new file when 

prompted.

Click on the Cell to open the Cell Edit dialog.

Click on the Sample Button on the Cell Edit dialog and a sim-

ple Waveform will be displayed.

You can use this to set the start and end points for the sample.

» In the Sample Waveform window, you can drag the start and end markers, use

the magnifying glass to zoom in (move the mouse over the waveform) and zoom

out using the option key or the command key (fit to window).

Move the start and end markers until you have a smooth loop.

»When a sample cell is set to follow MIDI note-on/off the sample always plays

from zero to the end mark and then, if looping is on, loops back to the loop point.

If key follow is NOT on then the sample always starts from the beginning of the

loop.

This example only works if MIDI key follow is off.
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Using CellSynth for Auditioning
Drum Loops – Part 2: 
Retuning Samples to Fit to Tempo

Now we can use a useful feature that automatically retunes a sample so

that it fits to the tempo (obviously, this will only be useful on samples

that don’t need to be at a particular pitch).

Open the Sample’s Cell Edit Window.

Switch on Sync and enter some appropriate settings in the Sync dialog.

See previous example for an explanation.

Now Command-Click on the Frequency dial. This will automatically retune

the sample so that it fits to the current tempo.

Fit to tempo assumes your Sample is 4 beats long. If your sample is

longer or shorter than four beats use the Control or Option-Click short-

cuts to make a quick adjustment.

Now repeat with as many drum loops as you want and you can quickly

see which loops work together and which don’t.

Once you have found suitable loops you may find they work retuned. If

not you can take them into another program for further editing, confi-

dent that they sound good together when they are played in sync.
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Using CellSynth with MIDI

Setting up CellSynth MIDI

Before you can use MIDI with CellSynth, you must have OMS v2.0 or

newer installed on your computer

» you can download the latest versions of OMS from the Opcode website, which

at the time of writing was at http://www.opcode.com).

Setting up OMS

From the Options menu choose Set MIDI channel… in the MIDI

submenu.

» CellSynth defaults to using MIDI channel 1. If you want to change this use the

above dialog.

From the Options menu choose Choose MIDI Input… in the MIDI

submenu.

This will display the OMS input selector dialog. Use this to choose your

MIDI source as you would in any other OMS application.

Playing Samples and / or Oscillator /
Synth Sounds with a MIDI Keyboard

Drag a Sine Cell onto the Matrix.

As you may have noticed, most of CellSynth’s cells can be controlled via

MIDI Controllers. This control is always available (providing MIDI has

been setup correctly). Clicking on a Cell’s Keyboard button enables MIDI

note-on/off control. This can also be done by clicking the Keyboard but-

ton on the Cell Edit dialog.

Add an Envelope Cell

A Sine Cell on its own does not give you the control you would expect

when playing a sound from a keyboard, as the sound will not stop when

you let go of the key. In order that the sound should stop playing when

you release the key, you will need to add an Envelope Cell and turn on

MIDI note on/off control as described above.

Drag an Envelope Cell onto the Matrix next to the Sine Cell.

» Turning on MIDI note on/off control on an Envelope Cell means that the enve-

lope goes into attack mode when a MIDI note-on is received and release mode

when a MIDI note-off is received.

Keyboard button enables
MIDI note-on/off control
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You have already enabled MIDI note on/off control on the Sine Cell. This

means that the MIDI note from your keyboard (sequencer or whatever)

is controlling the frequency of the Sine Cell, adjusting the frequency as

you play different notes.

By enabling MIDI Note on / off on the Envelope Cell, it means that the

note off information is controlling the Envelope Cell so that the note is

released when the key is released. This is, of course, how most MIDI

controllable synths operate.

You can adjust the envelope parameters manually using the ADSR edit

window:

If you leave both Cell’s unmuted, you will not hear the effect of the enve-

lope because you will still be hearing the output of the Sine Cell before it

has passed through the envelope. 

If you mute the Sine Cell (press the mute but-

ton in the cell edit dialog or command-

click cell in Matrix window) you will only hear

the output of the Envelope Cell.

» Recap - this is an important point to remember and should be taken into

account when designing any sound. If you don’t want to hear the original sound

source but just the treated sound, remember to mute the Cell providing the sound

source or it will still be going into the mix and heard at output.

Cells turn grey when muted.

Testing the Sound Using the Keyboard
Window

You can easily test your new sound even if you don’t have a MIDI con-

troller setup. Open the Keyboard Window by selecting “Show Keyboard

Window” from the “Options” menu. You can play the keyboard by clicking

on the keys with your mouse.

Testing the Sound Using a MIDI Keyboard

To play from a MIDI keyboard (or any MIDI controller) make sure you

have chosen your MIDI input in the OMS dialog accessed from the MIDI

submenu item “Choose MIDI input” (as described earlier),

and that the Controller is set to output on the same MIDI

channel.

CellSynth must be active (click the speaker icon on the

Matrix window or press spacebar) before it will receive

MIDI from an external controller.
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Synchronising to MIDI (or Internal)
Clock

CellSynth has its own internal Clock which can be used in a number of

ways, such as sync’ing the start point of looped samples, sync’ing

looped envelopes to produce a gated effect in time with the music. It is

also used to drive the Event Sequencer to produce sequences, arrange-

ments or many other interesting effects.

The tempo of the internal Clock can be set from the “Set Sync Tempo”

dialog accessed from the “Options” menu.

CellSynth can, alternatively, be Sync’ed to MIDI Clock from an external

source, such as a Sequencer or any MIDI device that can output MIDI

clock. This way CellSynth can be used as part of a larger MIDI setup.

To Sync CellSynth to an external Clock, select “Sync to MIDI Clock from

the “MIDI” submenu on “Options” menu.

CellSynth will immediately become active (you will see the Red LED glow),

waiting for the MIDI Clock to start.

As soon as CellSynth receives Song Start or Continue, it will start play-

ing in time with the External Clock.

» There are a number of shortcuts to help sync samples, envelopes and delay

lengths to tempo (if sync’ed to external clock set the internal clock to the same

tempo):

• Command-Click in a sample frequency dial to fit to tempo.

• Command-Click in a delay dial to fit delay to tempo.

• Command-Click in an envelope dial to fit A, D, S or R to tempo.

Now use Control-Click to divide by 2 and Option-Click to multiply by 2 to adjust

the value to the required multiple if necessary.

Using MIDI Control Messages

MIDI Control Messages can be used to great effect with CellSynth allow-

ing it to be controlled from an external source. Because of the flexibility

with which you can design your sounds, all sorts of possibilities are

available. Assigning Controllers to parameters is made easy by the

“learn” shortcut.

Two ways of assigning MIDI Controllers

CellSynth actually has two ways of assigning MIDI Controllers. It is

important to understand the Pro’s and Con’s of each. Each Cell has a

main parameter that can be controlled by MIDI Controllers. The controls

for setting this up appear in the Cell Edit dialog. 
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These two parameters are used to assign

which Controller will control the Cell and

what kind of range it will have. You can

Command - Click the Controller LCD to set

it to the last Controller received.

You can also assign a value to any Slider. This means that in actual fact,

any parameter can be controlled via MIDI. However, this is a low priority

function in CellSynth and if your Matrix is hitting your processor hard,

you may notice a lag between the adjustment and the response from the

Slider.

You can, in fact, assign the same controller in both the Cell Edit dialog

and the Fader as we are going to do in this next example, and then you

will get a good response and still be able to see the faders move on-

screen.

Setting up a MIDI Mixer

A simple, but very useful, example of using MIDI Control Messages is

using an external MIDI device to control the Gain (volume) of Cells,

enabling the various sounds to be mixed “live”.

First you need a MIDI device with several Sliders or knobs which you can

assign Control Numbers to. There are many such devices on the mar-

ket, and many synths now have a generous number of assignable con-

trols.

Make sure your MIDI device is transmitting on the same channel that

CellSynth is set to receive (Options-MDI-Set MIDI channel…) and that

the MIDI input the MIDI device will be transmitting to has been selected

in the “Choose MIDI input” dialog (Options-MIDI-Choose MIDI input).

A good example of a Matrix that has been setup to use with an external

MIDI device is “Sample 5 Loop Mixing and Playing” in the Matrix Files

folder (and accessible from the pop-up menu at the top of the Matrix

window (under Basic Examples 2). This Matrix has been setup to use

MIDI controllers 2 to 6. The Control Numbers are optionally displayed

(Options menu: MIDI: Show Controller Names) on each Cell in the Matrix

Window. You will also notice that five tear off Faders have been setup

for easy access.
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Assigning the MIDI Controller Numbers

Assuming you have set up your MIDI device with appropriate Control

Numbers, we can go on to assign the Control Numbers to the correct

Parameters.

You can either assign a control value to a parameter in the Cell Edit dia-

log or, if you plan to use Sliders, it can be done from the Slider itself.

See the explanation of the Pro’s and Con’s earlier in this chapter.

To assign a value in the Cell Edit dialog automatically, move the knob or

fader on your MIDI device and then command-click on the Controller

Parameter’s dial or numeric display and the value received will be set.

You can also set this by simply typing in the value or turning the dial

until the correct value is displayed. Adjust the Control Amount to give a

suitable range.

To create a Slider (which can be used independently of the Cell Edit win-

dow and also gives a visual reference of the Parameter’s value) click in

the Parameter’s LCD display and drag:

In this example the Sliders are controlling the Gain

Parameter of the Sample Cells. Because this is the

main MIDI controlled parameter on Sample Cells, and

we have already assigned a Controller in the Cell Edit

dialog, it is not necessary to set one here. However,

in order to see the Slider move on-screen, we can

still assign a MIDI Controller to the Slider as well. 

Simply move the control on your MIDI device that you wish to use and

command-click on the Fader. A dialog will appear with the value

CellSynth received from your MIDI device as its default. You can also set

the control range from this dialog:

Try experimenting with the Sample 5 Matrix example. Assign some con-

trollers to the Sliders from your own MIDI device.
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MIDI Controllers in the Event
Sequencer

Whilst we’re on the subject of MIDI Controllers, we could take a quick

look at how we might use MIDI controllers in the Event Sequencer.

The Event Sequencer is covered elsewhere in this manual but lets

remind ourselves that we can use the Event Sequencer to automate or

arrange sequences of events using MIDI controllers. Any Cell can be

controlled using MIDI controllers and therefore the possibilities are end-

less. You could automate filter sweeps, volume changes, delay length,

pan and so on.

By assigning Controllers to Sliders, any parameter can be controlled,

but it should be remembered that MIDI control over Sliders has a low

priority in CellSynth. For smooth response try and use the Cell’s main

parameter assigned in the Cell Edit dialog.

» Here are the Cells’ Main Controllable Parameters:

Sine gain (also known as volume!)

Square gain

Sawtooth gain

Triangle gain

Noise gain

Samples gain

Filters frequency

Mixer gain

Panner pan amount

Black Box gain

Delay delay length

Envelope gain

Reverb gain

Sequencer none

…but remember, you can also

change the values for Cells that

are modulating those heard in the

final output.
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Setting MIDI keyspan

When designing a Matrix with the idea of playing the sounds from a

MIDI keyboard, it can be useful to assign different sounds to different

areas of the keyboard. This is known as the Keyspan.

To set the Keyspan of a Cell, open the Cell Edit window and Option-Click

on the MIDI Note on/off button. 

This will open the Cell’s Keyspan window:

To set the Keyspan, either type in the note numbers manually or click on

the note at either end of the current keyspan and drag with the mouse.

How you might use Keyspan

Keyspan means that, although CellSynth only receives MIDI on one chan-

nel, you can control several sounds by spreading them across the key-

board. One example of this is if you had individual drum sounds. You

could assign a keyspan of one note to each sound so that you can play

the full kit from the keyboard. 

It also means that you could control them from the Event Sequencer,

which you could then use to arrange drum parts. Each cell that has MIDI

Note on/off activated will receive the output from the Event Sequencer,

so this is one Cell that can be placed anywhere on the Matrix and does

not need to be connected to the other Cells on the Matrix.

Each Sample Cell’s
Keyspan is set to a
different single note.

Drum pattern arranged in
the Event Sequencer using
the five notes assigned to
the Sample Cells
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Using MIDI Program Change
Messages to Load Matrix Files

If you are using CellSynth with an external sequencer or MIDI controller,

you can set up CellSynth to load a Matrix file when it receives a

Program Change message.

Place aliases of Matrix files in the MIDI Programs folder.

Those matrices can then be loaded via a MIDI program change.

If you rename the alias files so that they start with a number then they

will be correctly sorted.

eg:

if you have  aliases called

Bass Synth

Analog Lead

Digi Synth

Then rename them as...

001 Bass Synth

002 Analog Lead

003 Digi Synth

etc

The corresponding number will then be the MIDI program number.
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Using the CellSynth Library

CellSynth comes with annotated examples to help you get started.

These are stored in the ”Matrix Files” folder which means that (as long

as you keep this folder in the same folder as CellSynth) they can be

selected from the pop-up menu at the top of the Matrix window.

These examples have been designed to demonstrate various features of

CellSynth and to help you start thinking of how you might go about

designing a sound in CellSynth.

Because designing a sound in CellSynth often involves building the ele-

ments of a sound out of several Cells, a useful feature is to be able to

save sections of a Matrix in a library to be used again. 

CellSynth comes with a library of useful Matrix Files that can be used as

“building blocks” when creating your own sounds. These can be selected

from the pop-up menu and appear in a submenu called ~Library. You will

notice that all the file names begin with the • bullet character. When

you open any file starting with the bullet character, the Merge dialog will

automatically open.

You can make your own Library of useful “building blocks”. Supposing,

whilst designing a sound in CellSynth, you have created a killer dub echo

effect that really recreates the feel of those old analog beasts, and you

want to use it again and again with other sounds you have created. You

can save just that part of the Matrix and then merge it into other

Matrix files when you need that effect.

If you make a folder within the Matrix Files folder to store your library of

files, it will appear as a submenu in the pop-up menu (only displays one

folder deep).

If you also name your files pre-fixed with a • bullet character, the Merge

dialog will automatically open when you select it from the pop-up menu.

The bullet character is Option-8 on US and UK keyboards. You can use

the Key Caps utility on your Apple menu to locate it on other keyboard

layouts.

Here’s Bassy Wah, one of the

sounds supplied with CellSynth:

Go to the pop-up menu and select “• Delay Analog Echo Simulation”.

The Merge

window will

appear:



Page 44 – Using the CellSynth Library

Drag the Cells from the Right Hand Matrix (new) to the position you

require on the Left Hand Matrix (old).

This is what you get:

You can now “plug” the bassy wah sound into the echo by routing the signal

between the two groups of Cells (feed the signal from the filter to the echo).
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Using Note Values to Modulate Cells

You can still control Cells independently of MIDI if you require. 

If you mute an Event Sequencer Cell, it no longer outputs MIDI notes or

Control Messages. However, the notes can still be used to modulate a

neighbouring Cell if it is connected to it (click the semi-circle). In this

way you can control individual Cells and still have other Cells in the

Matrix responding to MIDI notes,either from an external MIDI

device/sequencer or from another Event Sequencer Cell.

You can also specify the number of bars into the arrangement an Event

Sequence starts playing. You could use a number of Event Sequencers,

each with a different section of an arrangement. By changing the start

times the piece can easily be rearranged.

Using MIDI controllers to Control Cell
Parameters

MIDI control messages can also be entered in the Event Sequencer. This

means that Cells can be altered using MIDI control messages, for exam-

ple, filter sweeps can be programmed in, sounds may be brought in and

out of the mix by adjusting their Cell’s volume, Delay length changes can

be programmed in, and so on.

Using the Event Sequencer

Overview

The Event Sequencer can be used in many ways to control CellSynth.

These can be broken down into three main categories: Using MIDI Notes

to play sounds that have MIDI Note on / off enabled, using the Note val-

ues to modulated neighbouring Cells, and finally, Using MIDI Controller

to control the parameters of Cells that have had controllers assigned to

them.

Using MIDI Notes to control Cells with
MIDI Note on / off enabled

Its most obvious function is to play MIDI notes that any Cell that has

MIDI Note on/off enabled will respond to. 

You can enter sequences that can be used to control synth type sounds,

creating basslines, arpeggios, riffs and melodies. You can also play

Samples, altering their pitch according to the notes entered.

Remember, although CellSynth only receives MIDI on one channel, you

can set the keyspan of each Cell allowing the sounds to be spread

across the range of the keyboard (option click Keyboard button in Cell

Edit dialog).

Because of CellSynth’s flexibility notes can also be used in unusual ways.

Read On!
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The Event Sequencer has a simple arpeggio already programmed in.

This can be useful for testing a sound without having to programme in

your own sequence and also give you an idea of how the Event

Sequencer works. There are some other examples provided on the

CellSynth CD. 

»When the Event Sequencer window is active, Import Sequence… and Export

Sequence… become available on the File menu.

First lets clear the default sequence. Select Clear Sequence from the

Edit menu (or use the shortcut command-b) 

Before entering any notes we need to set up the sequence correctly.

Look at the controls at the top of the window. 

First set the number of bars. We’ll make a short repeating sequence

two bars long, so change the “Bars” value to “2”. 

We want four beats in each bar so we can leave the beats per bar at

“4”.

» The Event Sequencer has two modes, one for entering notes and another for

entering Controllers. The Event Type pop-up is used to switch between the two

modes. 

Using the Event Sequencer Window

Open the example file in Basic Examples 2 called “Samples 1 Playing via

MIDI”.

Drag an Event Sequencer Cell to the

Matrix. Unless you plan to modulate

another cell directly rather than use

MIDI notes, you can place it anywhere

on the Matrix. Any Cell that has its MIDI

note on/off activated will receive the

notes you enter in the Event Sequencer.

Open the Cell Edit window. We’ll look at the options available once we

have entered our sequence, so lets click on the Edit button to go

straight to the Event Sequencer window.
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Hold down the Control key and the cursor will change to a pencil

signifying that you can enter a note when you click the mouse.

The bars are marked with solid grey lines for each beat and subdivisions

(32) as dotted lines. The bar lines are marked in red.

Find the position in the bar that you wish to enter your note and, refer-

ring to the notes on the left of the window, click to enter a note. The

length of the note will depend on how you set the snap control. The

default is 32, so the note will fill one square on the grid.

Once the note has been entered you can move, lengthen or delete it by

using the mouse and modifier keys:

Move the mouse near the end of the note to stretch it. The cur-

sor changes to a finger. Click to stretch.

Move the mouse over the note and when the open hand is dis-

played you can click and drag the note to a new position.

Hold down the Control key. The cursor changes to a pencil, as

when you entered the note. Move it over a note and it changes

to an eraser. Click to delete the note.

You can mute a note by command clicking on it. The note has a cross

though it when disabled.

Other keys are: 

Leave the Event Type pop-up on Note so as we will enter some notes

first.

Finally, you can alter the snap value. In this case we’ll

leave it on 32, giving a fine degree of control without turn-

ing snap off completely.

How to enter the notes

You will notice the notes of the keyboard are displayed down the left

hand side of the Event Sequencer window. You can scroll up and down

using the scroll bars (which also have buttons to zoom in and out)
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The cursor will change to signify that you can click and drag the mouse

up or down to change the value. The level is displayed graphically inside

the Controller event. Change the value of your event to 20. Keep your

eye on the Control Value at the top of the Window.

Enter some more events for Controller 50 at regular intervals and

increase the value so that it peaks at a 100 at the end of bar one and is

nearly back to 20 by the end of bar 2.

Now click on the Matrix window to bring

it to the front and open the Sample

Cell’s Edit window. You now need to

assign the same controller number to

the Sample Cell, so change the

Controller value to 50 and, so that we

have the full range available, set the

Control Amount to 127.

Press the space bar on your keyboard to play from the start of the

sequence.

You should hear the Bass sample rising and falling in volume as the

sequence loops. Use the spacebar on your keyboard to stop CellSynth

playing. You can make any adjustments you need and use the double

Option key for zoom in (drag marquee to choose zoom area) 

Option-Shift to zoom out.

» You can double click in the Event Sequencer window to start playing from the

nearest beat.

Enter a sequence of notes and you should hear your notes played on the

bass sample from Samples 1 ”Playing via MIDI“.

Inserting Controller Events

Now lets experiment by entering a Controller.

Switch the Event Sequencer into Controller mode using the Event Type

pop-up. Notice that the Controller numbers are now displayed down the

left side of the Event Sequencer window.

Now, again using the Control key on the keyboard, insert a Controller

Event on the line that represents the Controller Number that you want

to use. In this example lets use 50.

You can change the value of the

Controller from the control at the top

of the Event Sequencer window or by

moving your mouse so that it is near

to the right hand edge of the

Controller event. 
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click method to audition them. When you are satisfied close the Event

Sequencer window.

Lets take a quick look at the parameters in the Cell Edit dialog.

You can choose whether your sequence loops and whether it syncs to

the bar. If you switch sync on you will get the chance to specify at what

bar the sequence should start, what beat it should start on and how

many beats per bar it is. This way you can start your sequence at a

specific point in the arrangement. You can even use several Event

Sequencer Cells and bring them in at different bars, arranging your

piece of music in sections. This would make it easy to try different sec-

tions in different orders, simply by changing their start bar.
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Cell Edit Window

on keyboard:
Escape or Clear

Tab

Up/Down

m, s or k / e

Numbers

Shift + Arrow

Shift + Enter

* (asterisk)

/

with mouse:
Cmd + Click

Cmd + Click

Cmd + Click

Cmd + Click

Control + Click

Option + Click

closes the edit window

select next parameter

select parameter

mute, solo or keyboard / editor

type a number and it will be entered

directly into the selected parameter

select cell in Matrix window

edit selected cell in Matrix

multiply value by 2 (1 octave)

divide value by 2 (1 octave)

in a dial to reset it to default value

in sample frequency dial to fit tempo

in a delay dial to fit delay to tempo

in an envelope dial to fit A, D, or R

to tempo

a dial to divide by 2

a dial to multiply by 2

CellSynth Reference Guide

Keyboard Shortcuts

Matrix Window

on keyboard:
Space Bar

Tab

Arrows (cursor)

Cmd + Arrow

Cmd + Shift + Arrow

Enter / Return

Delete

with mouse:
Shift + Click

Cmd + Click

Control + Click

Option + Drag

play/stop

select next cell

select cell

move selected cell

copy selected cell

open editor for selected cell

delete selected cell

a cell to select / deselect

a cell to mute it

a cell solo it

selection to copy
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Event Sequencer Menu Items

Open Matrix…
Load a previously saved Matrix file.

A “Matrix” is the name given to a CellSynth patch or program.

Merge Matrix…
Displays the Merge window which lets you extract cells from a saved

Matrix and insert them into the current Matrix.

Close
This is only used to close some of the editing windows when using

CellSynth.

Save Matrix…
To save the current Matrix in memory to disk.

If you save the file into the “Matrix Files” folder then the Matrix will be

available in the popup menu in the round window. This can be a shortcut

to aid loading favourite files.

on keyboard:
Arrows / Tab

Shift + Arrows

Control + Arrows

Option + Arrows

Cmd + Arrows

Option + Cmd + Arrows

with mouse:
Control + Click

Option + Click

Option + Shift + Click

Option Drag

Cmd + Click

Double Click

select cell

extend selection

move by snap amount

duplicate selection

scroll

zoom

insert / delete event

zoom in

zoom out

copy / duplicate

mute event

play from cursor
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Import/Export…
Only active when a Harmonic editor windows or Event Sequencer window

is open.

Allows you to open or save harmonic tables or sequence files.

Save Recorded Audio…
To save the audio currently in the record buffer.

Use this after you have recorded audio that you want to keep.

CellSynth saves audio files in AIFF format.

Choose Record Disk…
CellSynth buffers its recordings to a temporary disk file. This menu

option allows you to select the disk or folder that you want to use as a

record buffer.

Set Record & Fade Times…
Displays a dialog that lets you set the length of the recording and a fade

out length.

Undo
Some (but not all) action in CellSynth are undoable.

Moving dials or sliders and cell deletions are undoable.

Undo can be particularly useful after accidentally moving a dial.

Clear Matrix (Clear Sequence)
Clears the current Matrix by deleting all of the cells and sets default val-

ues for tuning, volume and MIDI.

If an Event Sequencer window is open, and has the focus, this option

becomes Clear Sequence.

Select All
Selects all the cells in the Matrix, or if the Event Sequencer window is

open, and has the focus, this option selects all events in the sequence.

Preferences…
Shows a dialog that allows you to set the size of the CellSynth audio out-

put buffers.

If the audio output stutters you could try adjusting the buffer size.
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Sample Names Only
This limits the display of tooltips to just the names of the audio files in

the sample cells and the names of Event Sequencer cells.

Disable Tips
Disables the display of tooltips.

If you get annoyed by the tooltips, select this menu item!

Display Routing Arrows
Enables or displays the display of routing arrows in the Matrix.

Blue arrows show the routing of audio form one cell to another.

Red arrows show the routing of modulation from one cell to another.

Choose MIDI Input…
Opens the OMS input selection dialog.

To choose the MIDI source that will control CellSynth.

Set MIDI Channel…
Displays a dialog that lets you choose the MIDI channel that CellSynth

will use.

Sync to MIDI Clock
This activates CellSynth and puts it into a wait state.

CellSynth will start playing when it receives Song Start and MIDI clock

messages.

Note:- This overrides the internal tempo setting and CellSynth will now

play at the same tempo as the MIDI clock.

Reset MIDI Controllers
When this option is on (menu item is ticked) CellSynth will reset all MIDI

controller values when started.

When the option is off, the controller values are left in their previous

state.

Example:- You send MIDI control messages to adjust the volume of cells

in a matrix. When this option is on and you stop and restart CellSynth ,

the volume will be reset.

If the option is off the volume will be left as it was before restarting.
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OMS Studio Setup & MIDI Setup
These menu items call up the OMS Studio Setup and OMS MIDI Setup

applications. Refer to your OMS documentation for details on how to

use them.

Show Annotation Window…
Display the Annotation window in which you can type text or comments

about the Matrix. This text is also shown in the Merge window.

Auto Open
If this option is ticked and a Matrix file has annotation, the annotation

window is automatically opened when the Matrix file is opened.

Edit Annotation…
Enables / Disables typing in the annotation window.

Set Sync Tempo…
Shows a dialog that lets you set the internal clock tempo for CellSynth.

The clock is used by cells when the “Sync” switches in Cell Edit windows

are on.

Note:- this is overridden when the “Sync to MIDI Clock” option is on.

Enable Sound In…
Lets you select the sound input source for recording audio into

CellSynth.

Overload Protection

When enabled, Overload Protection will stop CellSynth if it detects that

the processor is overloaded and the System is not responding. If you

have a Matrix that is beyond the capability of your processor, this will

prevent CellSynth from appearing to “lock up”.

Show Recording Toolbar
Shows the tool window that contains the transport controls for record-

ing the output of CellSynth.
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Show Keyboard Window
Shows the MIDI keyboard window. This can be used to test and play

Matrix files that require MIDI note on/off.

Show Master Window
Shows the Master window. This is used to set the output volume and

global tuning for CellSynth.

Another way to open this window is to click on the Peak LEDs in the

round window.

CPU Load Indicator
Shows the window that indicates how much processing power CellSynth

is requiring. If the LED reaches the red area then the machine is strug-

gling and you should reduce the number of active Cells in the Matrix.

Note:- Reverb Cells are particularly heavy on processing, so if you are

using one or more reverbs you should delete these first.

Hide Sliders
Hides / Shows any floating slider windows that are in use. This is useful

if you have a lot of sliders and they are covering the main work area.

Cell Edit Parameters

Oscillator Cells - Sine, Square,
Sawtooth, Triangle and Harmonic

The parameters that appear on the Oscillator Cells appear on all but a

few Cells, with the exception of the Frequency and the Harmonic Editor

button, which only appears on the Harmonic Oscillator Cell.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

The amount of affect that the MIDI controller has.

Oscillator pitch. (Bottom C = 65.406, Middle A = 440,
Command Click reset to C, or click LCD and type a number)

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Solo: Mutes output of all cells
except this one. Enables MIDI note on to set the

pitch or frequency of the cell or
trigger an envelope cell.

Opens Harmonic Editor window.
(Harmonic Oscillator only)
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Harmonic Editor

The Harmonic Oscillator has an editor window. When you click on the

editor button the following window appears:

The musical term for

the various harmonics

are shown on the left

hand side of the window

for reference. These are

intervals in relation to

the fundamental.

You can enter values from the keyboard or use the pencil tool that

appears when you move your mouse into the edit LCD.

This sets the relative amplitude of the various harmonics allowing you to

create many variations of sound.

You can load and save Harmonic Tables from the File menu, when the

Harmonic Editor is active.

There are some examples provided in the “Harmonic Tables” folder

installed with CellSynth.

Random / Noise Cell

Used to produce random numbers for modulating other cells or, if set to

Frequency is set to zero, to output white noise.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

The amount of affect that the MIDI controller has.

The frequency of the random generator. 
Zero = white noise.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Syncs the frequency to MIDI or internal clock.

Solo: Mutes output of all cells
except this one.



Page 58 – CellSynth Reference Guide

Sample Cell

A Sample player. The sample can be triggered in Sync with CellSynth’s

internal clock or an external clock. It can be controlled via MIDI Note on

/ off, either externally or from the Event Sequencer. Modulation can be

routed to the Start point of the sample for some very weird effects!

Sample Editor

When you click on the Edit button the Sample Editor window appears.

You can set the Start and End points by dragging the red triangles 

(cursor changes to a hand ).

Click on the sample to zoom in 

(cursor changes to a magnifying glass with a plus sign ).

Option-click on the sample to zoom out 

(cursor changes to a magnifying glass with a minus sign )

Command-click on the sample to fit to the window 

(cursor changes to )

The sample will always start from the beginning if MIDI Note on/ off is

enabled and loop around the marked area.

If MIDI Note on / off is not enabled only the area marked will play.

Playback start point in seconds.

Multiplies the sampling frequency. 
1 = normal. Command Click to fit to current tempo.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Used with “Set Sync Tempo”
in the “Options” menu.
Sample can be triggered at
a defined bar/beat.

Playback length in seconds.

See Oscillator Cell for info

Solo: Mutes output of all cells
except this one. Enables MIDI note on to set the

pitch or frequency of the cell or
trigger an envelope cell.

Opens Sample Editor window. 

Turns on or off looping from start to end.

Routes modulation input to 
sample start point.

Routes modulation input to 
sample start point.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.
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Low / Band Pass Resonant Filter

This cell can be switched to act as either a Low or a Band Pass Filter.

Modulating this cell is like changing the “wah” on a “wah wah” pedal.

Modulating it with something like a Sine wave will give a smooth sweep

and a random cell will give a “sample and hold” type effect. 

Comb Filter

The Comb filter has an effect that is similar to a fixed Flanger or Phaser

(depending on the state of “Invert”). If you modulate this filter it will act

exactly like a Flanger or Phaser!

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

The amount of affect that the MIDI controller has.

The cutoff frequency of the filter.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Filter type: Lo or Band Pass Filter

The amount of resonance or “wah” of the filter.

Solo: Mutes output of all cells
except this one.

Enables MIDI note on to set the
frequency of the cell.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

The amount of affect that the MIDI controller has.

Lo Pass Filter cutoff

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Amount of Comb Feedback

Width of Comb section

Solo: Mutes output of all cells
except this one.

Inverts the Comb Feedback

Output level for the cell.
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Mixer

The Mixer Cell can be used to route signal around the Matrix, amplify or

attenuate, invert the signal, and ring modulate.

Panner

Used to position the sound in the stereo image.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

Inverts the signal going through the mixer. 

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Only applies when cell is being modulated.
On = ring modulation, 
Off = amplitude modulation

Makes the negative part of the signal positive.

Solo: Mutes output of all cells
except this one.

The amount of affect that the MIDI controller has.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

Balance between left and right. 
0 = L, 1= MID, 2 = R

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Solo: Mutes output of all cells
except this one.

The amount of affect that the MIDI controller has.
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Black Box

Can widen the stereo image as well as working like a Noise Gate and an

Expander.

Delay

Digital Delay effect. The delay length can be modulated.

Any signal above this threshold 
is decreased. zero = off.

Turns a mono signal into a wide stereo image.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Threshold below which nothing
is passed through the box.
zero = off.

Any signal below this threshold
is increased. zero = off.

See Oscillator Cell for info

Solo: Mutes output of all cells
except this one.

The amount of time that the effect lasts
before retriggering. zero = off.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

The amount of delay in millisecs. 
Command Click to set to current tempo.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Inverts the feedback signal.

The amount of feedback (or repeats).

Solo: Mutes output of all cells
except this one.

The amount of affect that the MIDI controller has.
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Reverb

Digital Reverb effect.

Envelope

Can be used as a free standing envelope or with MIDI note on / off (the

envelope goes into its decay phase when MID note off is received..

There is an Edit window for visual editing of the envelope.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Output level for the cell.

The MIDI controller that affects this cell.
Command+Click to set to last received MIDI control.

Multiplies the room size or reverberation delay.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

The amount of hi frequency falloff. 
0 = none,1 = normal, 3 = max.

The length of the reverb.

Solo: Mutes output of all cells
except this one.

The amount of affect that the MIDI controller has.

Attack: The time to go from
zero to max level in seconds.
Command+Click to fit to tempo.

Multiplies the sampling frequency. 
1 = normal. Command Click to fit to current tempo.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

Decay: The time to go from
max to sustain level in seconds.
Command+Click to fit to tempo.

Solo: Mutes output of all cells
except this one. Enables MIDI note on to trigger

the envelope cell.

Opens Envelope Editor window. 

Loop: Envelope starts again when decay
stage is complete.

Release: Time to go from sustain
level to zero when key is
released.
Command+Click to fit to tempo.

Amount of audio input from cell above, below, left and right.
There will only be a control if the Cell has a neighbour to
accept input from.

Amount of modulation from cell above, below, left
and right. There will only be a control if the Cell
has a neighbour to accept input from.

Sustain: The final level of
the envelope

See Oscillator Cell for info
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Envelope Editor

You can adjust the envelope visually by dragging the Attack, Decay and

Sustain points on the graph with your mouse.

When you adjust Decay, sustain may be affected and likewise, adjusting

Sustain may affect the Release time.

The values will be displayed as you move the points.

Event Sequencer

The Event Sequencer is like a Mini Sequencer. You can enter Notes

(which can either be output as MIDI notes or used to modulate a cell

directly). You can also enter MIDI Controllers and, by assigning

Controllers to Cell’s parameters, you can program in all sorts of events,

for example, volume changes (automate a mix), filter frequency changes,

delay length changes, and so on…

When you click on the Edit button, the Event Sequencer window opens:

Output level for the cell.
Only has effect when using Event
Sequencer to modulate another cell.
Multiplies the note values by the
value set. Will stretch or squash the
range of notes.

Mutes the audible output from this cell.
Cell remains active but cannot be heard

To set a bar number to start from

Opens the Event Sequencer window

If on, the sequence repeats.
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Event Sequencer Window

Control key displays the pencil.
Click to enter note or controller.

Set the length of the sequence in bars

Command - click to mute
note or controller.

Set the of Beats per Bar Set the Control Value of the highlighted
Controller (only available in Controller mode).

Choose whether to enter Notes or Controllers Snap value (4, 8, 16, 32 or Off)

Control key displays the eraser
when over a note or controller.
Click to delete note or controller.

Zoom in and out horizontally
and vertically (independently)

Option key turns the cursor to a magni-
fying glass. Click to fit to window, drag
to select area of zoom.

When you switch the Event sequencer in to
Controller mode, the Controller numbers
appear down the left hand side of the window.

Pointing the mouse at the end
of a note will display the finger
cursor. You can click and drag
to lengthen or shorten a note

When the mouse is pointing at
a note the hand cursor is dis-
played. You can click and drag
to move a note

Enter a Controller in the same way as notes: press the control
key so the pencil cursor appears. Click to enter a Controller in
line with the number you have assigned to the parameter you
wish to control.
To adjust the value with the mouse, point near the right edge
of the controller and the mouse changes to the cursor shown.
Drag up to increase the value and down to decrease.
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